
Keyboard Shortcuts 
Selecting 

One cell to the right →

One cell to the left ←

One cell down ↓ or Enter

One cell up ↑ or Shift + Enter 

One screen down Page Down

One screen up Page Up

Beginning of sheet (A1) Ctrl + Home

End of sheet (last cell) Ctrl + End

To the end of contiguous data Ctrl + Arrow or  
End + Arrow

A cell or range of cells Ctrl G or F5 
then enter 
address

Next sheet Ctrl + Page Down 

Previous sheet Ctrl + Page Up 

Whole column Ctrl + Space Bar 

Whole row Shift + Space Bar 

One more cell to the right Shift + →

One more cell to the left Shift + ←

One more cell up Shift + ↑

One more cell down Shift + ↓

All the contiguous data to the right Ctrl + Shift + → 

All the contiguous data to the left Ctrl + Shift + ← 

All the contiguous data up Ctrl + Shift + ↑ 

All the contiguous data down Ctrl + Shift + ↓ 

All cells Ctrl A

File Functions 
Open file Ctrl + O
Save file Ctrl + S
Close window Ctrl + W
New file Ctrl + N 
Print file Ctrl + P

Formatting 
Format cells Ctrl + 1
Bold Ctrl + B
Italic Ctrl + I
Underline Ctrl + U 



Function Keys 
Help F1

Edit cell formula F2

Paste Name box F3

Insert function Shift + F3

Toggle absolute / relative references F4

Go to specified cell F5

Go to next pane F6

Check spelling F7

Toggle extended mode F8

Recalculate F9

Activate ribbon options with letters F10

Auto Graph / Chart F11

Save As F12

Editing 
Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Undo Ctrl + Z

Redo Ctrl Y

Insert cells, rows, or columns Ctrl + +

Delete cells, rows, or columns Ctrl + -

Find Ctrl + F

Search and Replace Ctrl + H

Erase cell contents Delete

Finish cell formula and stay in cell Ctrl + Enter

Cancel edit Esc

Insert new line in cell Alt + Enter

Insert current date Ctrl + ;

Insert current time Ctrl + :

Toggle display between formulas vs. 
values 

Ctrl + `



Printing 
Select a print area 
Select desired range of cells, then from the Page 
Layout tab choose Set Print Area as shown below. 

 

Fit print to one page wide 
From the Page Layout tab choose 1 page for the width 
as shown below. 

 

Fit print to one page tall 
From the Page Layout tab choose 1 page for the 
height as shown below. 

 

Add header / footer 
From the Insert tab choose Header & Footer then type 
your text in the desired location. 

 

 



Print rows at top of each page 
From the Page Layout tab click Print Titles, then select 
the rows to repeat at top and click OK. 

 

 



PivotTables 
PivotTables allow you to arrange and summarize 
complex data in an easy-to-read report that is easy to 
manipulate.  To create a simple PivotTable, follow 
these steps: 

1. Start Excel and create or open your file. 

2. Make sure your data can support a PivotTable by 
using the check list below: 

 Each column of data has a column heading 

 Each column heading is unique 

 Each column heading is in the same row 

 The column headings do not span multiple rows 

 No merged cells exist 

 All the data is contiguous 

 The data in each column follows a consistent 
format 

3. Position the cursor in one cell, and only one cell of 
the data. 

 

4. From the ribbon choose Insert, PivotTable. 

 

5. In the resulting dialog box make sure the 
table/range is referring to the correct table or 
range and that the destination is a New Worksheet, 
then click OK. 

 



6. Drag the fields from the PivotTable Field List to the 
desired location as shown below. 

 

You now have a PivotTable. 

 



Sort data 
To sort your data, click on one cell, that has data, in 
the column you want sorted.  Then from the ribbon’s 
Data tab click one of the three sort buttons. 

 

 

Sort lowest to highest 

 

Sort highest to lowest

 
Custom sort – lets you do a multi-column 
sort. 

 

 



Filter data 
From the ribbon choose Data, Filter.   

 

Then click the column heading’s drop down to apply 
the desired filter. 

 



Formula basics 
Range Operators 

Cell 
address 
with no 
operator 

Refers to cell 
address 

B2 

 

: Refers to all 
cells between 
first and last 
reference 

A1:C3 

 

, Refers to first 
and last 
reference 

A1,C3

 

! Refers to 
address on the 
specified sheet 

Sheet2!B2

 

$ Designates that 
a column or row 
reference is 
absolute and 
therefore 
cannot change 
when copied.

=$A$1 + 1

 

Formula Operators 
Every formula must begin with an equal, plus or minus sign. 

+ Add = 20 + 2  22 

- Subtract = 20 – 2 18

* Multiply = 20 * 2  40 

/ Divide = 20 / 2 10

^ Exponent = 20 ^ 2 400 

& Concatenate = 20 & 2 202 

= Equals = 20 = 10 FALSE

> Greater than = 20 > 10  TRUE 

>= Greater than 
or equal to 

= 20 >= 10 TRUE

< Less than = 20 < 10  FALSE 

<= Less than or 
equal to 

= 20 <= 10 FALSE

(  ) Expressions inside 
parentheses occur 
before other 
expressions

= ( 3 + 4 ) * 2

= 3 + ( 4 * 2 ) 

14 

11 



Order of Operations 
Excel follows the standard PEMDAS order of 
operations.  This means expressions are performed in 
the following order: 

1 P Parenthesis ( ) 

2 E Exponents ^

3 MD Multiplication and Division * / 

4 AS Addition and Subtraction + - 

Formulas vs. Functions 
Formulas and functions are not the same thing.   

A simple formula is an equation that involves use of 
operators like + - * / and &.   

A function is a predefined programmed calculation 
that has a name, a set of parentheses, and usually has 
one or more parameters.   

Complex formulas often combine one or more simple 
formulas and/or one or more functions. 

Sample Formulas 
Addition = A1 + B1 = A1 + 3 

Subtraction = A1 – B1 = A1 – 3

Multiply = A1 * B1 = A1 * 3

Divide = A1 / B1 = A1 / 3 

Concatenation = A1 & B1 = “John ” & “Adams”

Sample Functions 
Sum =Sum(A1:A10) Totals values in A1 through 

A10.

Average =Average(A1:A10) Calculates the average of 
the values in A1 through 
A10.

Count =Count(A1:A10) Counts the cells with 
numeric data in A1 through 
A10.

CountA =CountA(A1:A10) Counts the cells with alpha 
or numeric data in A1 
through A10.

Sample Complex Formula 
= “Your half of the total is “ & ( SUM(A1:A10) / 2 ) & “.” 



Expand the formula bar 
When you have a long / complex formula you might 
want an expanded formula bar so you can see the 
whole thing.  Just click the expand button shown 
below.  After that you can drag the border with the 
mouse to make it even bigger. 

 

Absolute, Mixed, and Relative References 
When a formula is copied from one cell to another, 
you have four options for how the formula’s cell 
addresses will be adjusted relative to the new vs. 
original location.  You select the options you want by 
choosing whether or not to place a $ in front of the 
row number and/or column letter. 

Absolute Reference – nothing changes 
Use a $ in front of both the column letter and row 
number 

 

No matter where the destination cell is, the row 
number and the column letter will not change. 

In this example, when B2 is copied down to a cell in 
row 3, the “1” stays a “1” because the $ in front of 
the row letter makes it absolute. 

When B2 is copied across to a cell in column C, the 
column letter remains an “A” because the 
proceeding $ makes it absolute. 

 



Relative Row, Absolute Column 
Use a $ in front of the column letter but not the row 
number 

 

Based on the destination cell, the row number can 
change but the column letter will not change. 

In this example, when B2 is copied down to a cell in 
row 3, the “1” becomes a “2”.  

When B2 is copied across to a cell in column C, the 
column letter remains an “A” because the preceding 
$ makes it absolute. 

 

Absolute Row, Relative Column 
Use a $ in front of the row number but not the 
column letter. 

 

Based on the destination cell, the row number will 
not change but the column letter can change. 

In this example, when B2 is copied down to a cell in 
row 3, the “1” remains a “1” because the $ in front 
of the row letter makes it absolute. 

When B2 is copied across to a cell in column C, the 
column letter changes to a “B”. 

 



Relative Reference 
Do not place a $ in front of the row number and do 
not place a $ before the column letter. 

 

Based on the destination cell, both the row number 
and the column letter can change. 

In this example, when B2 is copied down to a cell in 
row 3, the “1” becomes a “2”.  

When B2 is copied across to a cell in column C, the 
column letter changes to a “B”. 



Advanced Functions 

VLookup 
Description Looks for a value in the first column of a table 

and then returns the value from the specified 
column of that same row

Syntax VLOOKUP(Lookup_value, Table_array, 
Col_index_num, [Range_lookup])

Arguments Lookup_
value

Req’d The value to find 

Table_ 
array 

Req’d The table or range of cells 
where the value can be 
found 

Col_ 
index_ 
num

Req’d The column number in the 
table from which the value 
is to be returned

Range_ 
lookup 

Opt Leave blank or enter TRUE 
to find the closest match, 
enter FALSE to find only 
an exact match 

Notes If the Range_lookup is blank or TRUE then the 
data must be sorted in ascending order. 

Example 

 



XLookup 
Description Looks for a value in a column and then returns 

the value from the same row of a 
corresponding column 

Syntax XLOOKUP(Lookup_value, Lookup_array, 
Return_array, [If_not_found], [Match_mode], 
[Search_mode])

Arguments Lookup_ 
value

Req’d The value to find 

Lookup_ 
array 

Req’d The column or range of 
cells where the value 
can be found

Return_ 
array 

Req’d The column or range of 
cells where the desired 
value can be found 

If_ 
not_ 
found

Opt Value to display if the 
Lookup_value is not 
found

Match_ 
mode 

Opt 0 or blank for exact 
match 
-1 for exact match or 
next smaller item 
1 for exact match or 
next larger item 
2 for wildcard 
character match

Search_ 
mode 

Opt 1 or blank for search of 
first-to-last 
-1 for search of last-to-
first 
2 for binary search 
(sorted in ascending 
order) 
-2 for binary search 
(sorted in descending 
order) 

Example 

 



If 
Description Evaluates a logical expression.  If the 

expression is true one value is returned, if not 
another value is returned. 

Syntax IF(Logical_test, [Value_if_true], [Value_if_false]) 

Arguments Logical_ 
test

Req’d The expression that is 
either TRUE or FALSE 

Value_ 
if_true 

Opt The value you want 
returned if the logical 
expression is TRUE 

Value_ 
if_false 

Opt The value you want 
returned if the logical 
expression is FALSE 

Example 

SumIf 
Description Sums the number of cells in a range that match 

a given criteria

Syntax SUMIF(Range, Criteria, [Sum_range]) 

Arguments Range Req’d The set of cells to test 

Criteria Req’d The condition the cells 
must match in order to be 
added 

Sum_ 
range 

Opt The cells that are to be 
added.  If left blank the 
cells in the range 
parameter are used.

Example 

 

 



CountIf 
Description Counts the number of cells in a range that 

match a given criteria

Syntax COUNTIF(Range, Criteria)

Arguments Range Req’d The set of cells to count 

Criteria Req’d The condition the cells must 
match in order to be 
counted

Example 

 

 

SumIfs 
Description Sums the number of cells in a range that match 

all the given criteria 

Syntax SUMIFS(Criteria_range1, Criteria1, 
[Criteria_range2],[Criteria2]…) 

Arguments Sum_ 
range 

Req’d The cells that are 
to be added 

Criteria_ 
range1 

Req’d The first set of 
cells to be 
evaluated

Criteria Req’d The criteria the 
first set must 
match

Criteria_ 
range2 

Opt The second set of 
cells to be 
evaluated 

Criteria2 Opt The criteria the 
first set must 
match

Notes The criteria can be literal text or cell references. 
Literal criteria should be placed inside quotes. 
Operators like =, >, <  can be used as part of 
the criteria. Use ? and * as wildcards to 
represent one or multiple characters.

Example 

 

 



CountIfs 
Description Counts the number of records in a range that 

match all the given criteria

Syntax COUNTIFS(Criteria_range1, Criteria1, 
[Criteria_range2],[Criteria2]…)

Arguments Criteria_ 
range1 

Req’d The first set of 
cells to be 
evaluated 

Criteria Req’d The criteria the 
first set must 
match

Criteria_ 
range2 

Opt The second set of 
cells to be 
evaluated

Criteria2 Opt The criteria the 
first set must 
match 

Notes The criteria can be literal text or cell references. 
Literal criteria should be placed inside quotes. 
Operators like =, >, <  can be used as part of 
the criteria. Use ? and * as wildcards to 
represent one or multiple characters. 

Example 

 

 
 


